
The following is an excerpt from the book: Revit Essentials for Architecture by Paul F. Aubin.

In order to follow along in the exercises, please visit:

https://paulaubin.com/books/revit-essentials-for-architecture/

There you can find links to download the book's dataset files. You can also find information on 

ordering a copy if you are interested. Thank you.
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 Ö In the “Open” dialog box, browse to the Chapter02 folder.

 Ö Double-click Chapter02.rvt to open the project. You can also select it and then click the Open button.

The project will open in displaying a sheet with an overhead 3D view.

The dataset for this chapter provided courtesy of Mark Schmieding, FAIA.

GETTING ACQUAINTED WITH THE PROJECT

For this tutorial, we will explore a series of sheet views included in the project. A sheet view is a special kind of view 
that emulates a sheet of paper from which drawing sets can be printed to output devices. Sheet views typically include 
a title block which contains project and drawing information. Revit remembers the last view that was open when 
the project was saved. In this case, it is a three-dimensional aerial view of this small one-floor project for a youth 
center. It includes offices, exam and counseling rooms, a multipurpose room, and media rooms. Let’s take a closer 
look (see Figure 2.10).

FIGURE 2.10 The Youth Center dataset shown from the “Function Diagram” sheet

VIEW NAVIGATION

You can use the wheel on your mouse to zoom in and out in any view. You can hold the wheel in and drag to pan the 
screen. If you are working on a laptop and don’t have a wheel mouse, you can use the commands on the Navigation 
Bar (located by default in the upper right corner of the view window) to navigate in any view. Depending on the 
kind of view active on screen, you will have access to differing tools on the Navigation Bar (see Figure 2.11). Among 
these are the Steering Wheel, the Zoom pop-up, and the ViewCube. The ViewCube and 3D steering wheel appear 
in 3D views.
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FIGURE 2.13 Tool Tips will indicate the element category, family, and type

The tool tip conveys three bits of information about the element highlighted—its Category : Family name: Type 
name. So, in this case, the element category is “Viewports,” the family is “Viewport” and the type is “No Title.”

2. Now hover the pointer over a piece of text but do not click.

This is called “Pre-highlighting.” The tool tip for a piece of text will read—Text Notes : Text : 3D Notes. Here, Text 
Notes is the category, Text is the family and 3D Notes is the type. Since the 3D view is a viewport containing one 
of our project views, you do not see the elements within the model pre-highlighting. However, you can choose to 

“Activate” the viewport and that will give you access to the building model elements shown within the view. Editing 
them from a viewport is no different than opening the view from the Project Browser and editing them there; the 
results are the same view either way. Let’s take a look.

3. Pre-highlight the viewport, and then click to select it this time.

 Ö On the Modify | Viewports ribbon, click the Activate View button (you can double-click inside the viewport as well).

Notice that the sheet title block and the text labels have grayed out. While they are still visible, this graying effect 
indicates that they are currently inactive and that you are now working inside the viewport.

4. Move the mouse around the model.

Notice that the elements within the model now pre-highlight.

Copyri
ghted

 m
ate

ria
l

 
Copyright (c) 2020 Paul F. Aubin, All rights reserved



• Revit Essentials for Architecture •

Conceptual Underpinnings of Revit | 55

FIGURE 2.14 Once the viewport is activated, you can pre-highlight the elements in the model

We will not actually edit any model objects in this view but do take notice of the tool tips. The interior partitions, 
for example, display as: Walls : Basic Wall : Generic - 6". The category is: Walls, the family is: Basic Wall and the 
type is: Generic - 6" (see Figure 2.14).

Feel free to select objects if you like, but don’t edit anything. If you accidentally move or change an element, click 
the undo icon on the Quick Access Toolbar (QAT) at the top left corner of the Revit interface. Or press ctrl + z.

You may also notice that with the three-dimensional view now active, in addition to the Navigation Bar, the ViewCube 
is also displayed. The ViewCube is a 3D navigational tool available in all Autodesk products. Clicking on any of the 
labeled sides of the cube will orient the view to that direction such as top, front, or right. There are also several active 
regions between faces that will orient the view at an angle between the two adjacent faces. For example, click the 
edge between front and right to orient the view to the southeast. Click the corner between three faces to orient the 
view to an axonometric orientation. You can also click and drag any edge of the cube to orbit the model in real-time. 
Feel free to experiment with the ViewCube to get the hang of it (see Figure 2.15).

FIGURE 2.15 Three-dimensional views show the ViewCube. Use it to quickly reorient the 3D view

In addition to the ViewCube, the Steering Wheel has more options in a three-dimensional view. You can orbit the 
view, change the center of rotation, move the vantage point up and down, and walk and look around the model. 
Consult the online help for more information on these options and the many ways you can customize the Steering 
Wheels to suit your preferences.

5. Feel free to experiment with the ViewCube and the 3D Steering Wheel in this 3D view.

 Ö Before continuing, reset the view back to its original state.
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To do this, click the Steering Wheel, and then use the Rewind tool or right-click on 
the Steering Wheel and choose: Undo View Orientation Changes.

6. When you are done exploring in the model, right-click in the Viewport again and choose: Deactivate View.

This returns you to the sheet and the elements in the view are no longer selectable.

VIEWS AND DETAILING

Earlier we discussed how model and annotation elements were handled in distinct ways. Continuing in this file, let’s 
explore the difference between model and view-specific/annotation elements a bit further.

1. On the Project Browser, beneath the Views (all) branch, double-click to open the: _Main Floor plan view.

This is the basic floor plan view for this project.

2. On the Project Browser, double-click to open the _Room Callouts plan view.

This plan is very similar to the _Main Floor view except that it also includes callouts around the General Purpose 
Room on the left and some elevation and section markers. A sheet has been provided showing each of these views.

3. On the Project Browser, beneath the Sheets (all) branch, double-click to open the 05 – Room Callout sheet view.

Notice how the only visual difference here is that the plan appears on a title block sheet in this view.

4. On the Project Browser, double-click to open the 02 – Floor Plan sheet view.

This is the sheet presentation of the _Main Floor plan view. In other words, this sheet composes the _Main Floor plan 
view on a title block for printing. You can easily see which views appear on a sheet in the Project Browser.

5. On the Project Browser, beneath the Sheets branch, expand the tree (click 
the small plus (+) sign) beneath the 01 – Shaded Plan sheet.

 Ö Double-click the sheet to open it (see Figure 2.16).

FIGURE 2.16 Expand the sheet entries in the Project Browser to see the views they contain
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 Ö In the dialog that appears, for Space Type, choose: Rooms and then click OK.

As you can see, the Scheme 1 color scheme color codes each room based on its name. The legend itself is currently 
overlapping the plan. To make it fit better, we can resize and/or move it.

13. Click on the Color Fill Legend and then drag the small round Control at the 
bottom up to make the legend two columns (see Figure 2.17).

FIGURE 2.17 Create a Legend for the new shaded plan and then resize the legend

14. On the Project Browser, double-click to open the 04 – Area Diagram sheet view.

A sheet appears on screen, which does not yet have a drawing on it. Let’s add our new shaded plan to this sheet.

 Ö On the Project Browser, right-click the 04 – Area Diagram sheet and choose: Add View.

 Ö From the “Views” dialog, choose: Floor Plan: Area Diagram view and then click the Add View to Sheet button.

 Ö Click to place the view on the sheet.

Notice that the view is a little too big for the sheet. We can adjust the scale of the view and it will update automat-
ically on the sheet.

15. On the Project Browser, select the: Area Diagram view.

 Ö On the Properties palette, from the View Scale list, choose: 1/8"=1'-0" (see Figure 2.18).
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FIGURE 2.18 Change the scale of the view

You should see the change on the sheet immediately. If necessary, you can move 
the viewport around to make a nicer composition on the sheet.

You should also look at the _Furniture Plan floor plan view and the 03– Layout Plan sheet next. In this view and 
sheet, you will notice that the plan is displayed with furniture. Therefore, creating plans with and without detailing 
(text and other annotation) is not the only way to vary the specifics of what we see. We can also control the visibility 
of each type of element in any Revit view. The visibility settings are a parameter of the view itself. This is how we 
can choose to display the furniture in the _Furniture Plan view and not display it in the _Main Floor view. On the 
View tab of the ribbon, on the Graphics panel, you can choose the Visibility/ Graphics tool (VG). This will display 
a dialog listing all element categories and enables you to turn on and off these categories within the current view. 
While we will discuss the specifics of this process in later chapters, the important point for this exercise is that this 
sort of control is possible and extremely useful. If you wish to explore the “Visibility/Graphics Overrides” dialog, 
please feel free to do so. Simply undo your changes before continuing with the lesson.

EDIT IN ANY VIEW

Perhaps the most powerful feature of Revit is the ability to edit in any view and see the results instantly in all views.

1. On the Project Browser, double-click to open the 06 – General Purpose Room sheet 
view. Then on the View tab, on the Windows panel, click the Close Inactive button.

This closes all the other tabs. As you can see from this simple exercise, it is easy to end up with many open view tabs. 
Using this tool every so often helps keep a tidy workspace and preserves computer resources. The 06 sheet we have 
open shows a plan and four interior elevations. All these views show the General Purpose Room.

2. Select the plan view on the left, right-click and choose: Activate View (or double-click on the viewport).

3. On the Architecture tab of the ribbon click the Window tool.

 Ö Click a point on the exterior wall on the left to add a new window (see Figure 2.19).Copyri
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FIGURE 2.19 Add a window and it appears in all appropriate views automatically

Notice that the window appears immediately in the north elevation (detail 5 on the sheet).

4. Right-click in the plan view again and choose: Deactivate View.

EXPLORE A DETAIL VIEW

As we have noted above, a detail view is a little different than the other views. Typically it will include a live view of 
the model—usually a callout of some part of a section or plan—and various types of annotation and other graphical 
embellishments drawn on top. One such detail view has been included in this sample dataset.

1. On the Project Browser, expand (click the plus [+] sign) the 07 – Building Details sheet view.

Beneath this sheet is a listing of three views that are already placed on the sheet.

 Ö Beneath the 07 – Building Details sheet view entry, double-click to open the: Section : Section Detail view.

2. Pre-highlight some of the elements in this view (see Figure 2.20).

FIGURE 2.20 Explore a detail view—Note the combination of detail and model elements

Notice that the detail view contains both model elements (which would appear in all views) and detail elements 
(which appear only in this view). Even though the detail elements represent items like concrete blocks, brick, flashing, 
and bond beams, the level of detail required in a construction detail is much higher than that required in nearly any 
other view. Therefore, these types of items are typically drawn as detail elements on top of the model view geometry 
to keep overhead low and reduce the amount of time and effort required to build your overall model. An even easier 
way to see this is to change the way the model displays on the Properties palette.

3. Make sure that nothing is selected (press esc). On the Properties palette, next to Display Model, choose: Halftone.

Notice how the elements that are parts of the 3D model now display grayed out.

 Ö Set it to: Do not display next.
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This time the model disappears and only the detailing remains.

FIGURE 2.21 Change the display properties of detailing to see the difference between model and detailing more clearly

Complete coverage of the detailing procedure can be found in Chapter 12. Continue to explore in this dataset as 
much as you wish to get a better feel of how the various elements and views in a Revit project interact. Close Revit 
when you are finished exploring. You do not need to save the file.
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This completes the editing of our family and returns us to the project editor mode.

JOIN THE FIREPLACE WITH THE WALL

The Fireplace family is finished but it overlaps the wall. Let’s fix this.

1. On the Modify tab, click the Split tool (or type SL).

 Ö On the Options Bar, place a checkmark in the “Delete Inner Segment” check box.

2. Split the exterior vertical wall on both sides of the fireplace (see Figure 4.65).

FIGURE 4.65 Split the exterior wall

3. Click the Modify tool or press the esc key twice.

This is close to what we want but let’s make one more edit.

4. On the Modify tab, on the Geometry panel, click the Join tool (see the top of Figure 4.65).

 Ö Click one of the exterior walls (the ones we just split).

 Ö Then click the Fireplace to join them (see Figure 4.66).

TIP: Remember to watch the Status Bar for detailed prompts.

5. Repeat for the other wall. Pick the wall then the fireplace.

FIGURE 4.66 Use Join Geometry to join the walls to the Fireplace
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6. Click the Modify tool or press the esc key twice to cancel the Join command.

7. On the QAT, click the Default 3D view icon.

 Ö Use the techniques covered above and orbit the model around so that you can see the Fireplace.

We modeled the fireplace a bit too short. However, for now we will leave this alone. In later chapters we will address 
the height of the fireplace as well as how it changes width on the second floor. The fireplace could also use a mantel 
and a hearth. However, because there will be no new work done in the living room of this project and therefore no 
sections or elevations are needed of the fireplace, that extra level of detail is unnecessary for this tutorial. What we 
have created works well for the floor plan. If you wish to try it anyway for the practice, feel free. Select the fireplace, 
and then on the Modify | Generic Models tab, click the Edit In-Place button. This will return you to the in-place 
family editor where you can add these accoutrements using additional solids.

RESET THE CURRENT PHASE

Congratulations! Our work on residential project first floor existing conditions layout is complete for now (see Figure 
4.67). We still need to add the Stairs to this model. However, Stairs will be covered in a dedicated chapter. Therefore, 
we will save our layout without the Stairs for now.

FIGURE 4.67 The final first floor existing conditions layout
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CREATE A SHEET LIST

Revit makes it easy to create a list of all the drawing sheets in our project. A sheet list will resemble the other schedules 
that we already have, and it can even be placed on a sheet as a sheet index. Furthermore, it can be used to help us 
create and edit the sheets in our project. Let’s create a sheet list and then use it to add more sheets.

1. On the Project Browser, right-click on the Schedules/Quantities branch and choose: New Sheet List.

Ö In the “Sheet List Properties” dialog, select Sheet Number and then click the Add parameter icon in the middle.

Ö Add additional fields like Sheet Name, Drawn by, Checked by, Sheet Issue Date and Guide Grid.

TIP: As an alternative to clicking the Add icon, simply double-click the field you want to add.

2. Click the Sorting/Grouping tab.

Ö For Sort by, choose: Sheet Number and then click OK.

Fields like drawn by, checked by, and other similar text fields must be edited individually on each sheet. However, 
one of the benefits of the Sheet List schedule is that you can edit those values directly in the table, which is usually 
more efficient than doing them individually. Another key advantage to the Sheet List Schedule is that we can use it 
to create Sheets. Think of it as queuing up list of available sheets, complete with pertinent information filled in and 
ready to add to the project.

3. On the Modify Schedule/Quantities tab, on the Rows panel, click the Insert Data Row button.

A new row will appear in the Schedule. It will automatically number as sheet A102. Using this method, you can 
create several “placeholder” sheets and fill in their values in the other columns of the Schedule.

Ö For the name of A102, begin typing: Floor Plans. After the first letter or two, Revit will guess the name from
your previously input values. You can keep typing, or just choose from the mini pop-up (see Figure 5.46).

FIGURE 5.46 Create a drawing list and use Insert Data Row to add a placeholder sheet

Ö You can input your own initials in the “Drawn By” and “Checked
By” fields and input a date for sheet issuance if you like.

Using Table 5.A, we’ll set up the rest of the floor and ceiling plan sheets.
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OPEN THE RESIDENTIAL PROJECT
Be sure that the Commercial project has been closed and saved.

1. On the QAT, click the Open icon (or press ctrl + o).

 Ö Browse to the Chapter06 folder.

2. Double-click 06 Residential.rvt if you wish to work in Imperial units. Double-click 06 Residential Metric.
rvt if you wish to work in Metric units. You can also select it and then click the Open button.

The project will open to a cover sheet showing a 3D view of the model. The First Floor view looks like it in Chapter 
4 with the exception of some new walls boxing out where the addition will be. The Second Floor and Basement floor 
plan views have been provided for you. If you wish to gain some additional practice modeling the elements on these 
levels yourself, refer to the Appendix (included as a PDF) for exercises covering the layout of these levels.

ADD CONTINUOUS FOOTINGS

You can create three types of footings in Revit: Wall Foundation, Isolated Foundation, and Slab Foundation. A wall 
foundation is very easy to add and is associated with existing walls. An isolated foundation is a component family 
that can be inserted anywhere a footing is required, such as a pier footing, pile cap, etc. A slab foundation is a sketch-
based element drawn just like a floor element that you can sketch any shape that is required. They are categorized 
as foundations however, and share characteristics with other types of foundations. Foundation tools are accessed on 
the Structure tab of the ribbon from the Foundation panel.

1. On the Project Browser, double-click to open the Basement floor plan view.

2. On the Structure tab, on the Foundation panel, click the Wall Foundation tool (see Figure 6.41).

FIGURE 6.41 Create a Wall Foundation

 Ö From the Type Selector choose: Bearing Footing - 36" x 12" [Bearing Footing -900 × 300].

A “Select Wall(s)” prompt will appear on the Status Bar (lower-left corner of the application frame).

We are adding footings only to the new construction. The new construction for the addition is bold and black while 
the existing construction is gray in color. There are three new construction walls in the addition at the top of the plan.

3. Click the vertical new construction wall on the left of the addition (top left of the plan).

A “Warning” message will appear in the lower right corner of the screen (see Figure 6.42). This is considered an 
“Ignorable” Warning message in Revit. It indicates a situation to which you should be made aware, but if you choose 
to ignore it, this condition does not prevent you from continuing your work. In this case, the Foundation that we 
just added is not visible in the current view because it is placed at the bottom of the wall which is outside the view 
range of this floor plan. We must perform a few steps to correct this and display the Foundations.Copyri
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OVERRIDE VISIBILITY/GRAPHICS

It can certainly be appropriate to globally change the definition of the <Beyond> Line Style throughout the entire 
project. But it is sometimes better to apply a change like the one suggested in the previous topic only to the current view.

1. On the View tab, on the Graphics panel, click the Visibility/Graphic button (or press VG).

Changes made in this dialog affect only the current view (Basement in this case).

2. On the Model Categories tab, scroll down and expand the Lines category.

 Ö Select the <Beyond> item.

 Ö Click the Override button that appears in the Lines column.

3. In the “Line Graphics” dialog, change the Pattern to Hidden and then click OK once and then click 
the Apply button to see the change in the view window (see the left side of Figure 6.44).

FIGURE 6.44 Edit the surface pattern for structural foundations

4. Scroll down and select the Structural Foundations category.

 Ö In the Projection/Surface, Patterns column, click the Override button.

 Ö Clear the “Visible” check box and then click OK twice (see the right side of Figure 6.44).

These visibility edits apply at the category level for this view. This means that any new foundation elements that you 
add to this view will display using the same visibility settings.

5. Add two more Footings to the other two walls of the addition.

TIP: Select the footing already in the model and then click the Create Similar tool on the ribbon or type “CS”. 
The Create Similar tool allows you to use the elements visible within the Canvas as an onscreen tool palette.

 Ö On the ribbon, click the Modify tool or press the esc key twice.
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FIGURE 6.46 The completed foundation in the {3D} view (with the Toposurface hidden)

There is plenty more that we could do to finish up the foundation of the residential project. We could add existing 
Footings (remember to work in that phase) or we could add an Isolated Foundation to the chimney and the columns 
in the basement. We could also add isolated Foundations at each column in the Commercial project. When you 
choose the Isolated Foundation tool, you will be prompted to load a family for its use. This is left to the reader as an 
additional exercise. Feel free to experiment in both projects with these and other structural tools.
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2. Select the remaining model group instance on screen.

3. On the Modify panel, click the Mirror -Pick Axis button (or press MM).

 Ö For the mirror edge click on the centerline of the vertical wall on the right side of the group (see Figure 7.11).

FIGURE 7.11 Mirror a copy of the Guest Room A group

When you complete the mirror command, a copy of the group will appear, and a warning dialog will also appear at 
the bottom right corner of the screen. This warning is not serious and can be ignored. All such “ignorable” warnings 
will appear in this location on screen and will have a yellow tint to the dialog in which they appear. It is still a good 
idea to read the warning message as there is some useful information conveyed in them. In this case, Revit is alerting 
us that we now have two walls overlapping in the same spot. While we can ignore this situation, the message further 
explains that room boundaries may be affected. If you click anywhere, the message disappears. So, if you missed it, 
here is the complete text of the warning:

“Highlighted walls overlap. One of them may be ignored when Revit finds room boundaries. Use Cut Geometry to embed one wall within the other or 
tab-select one of the grouped overlapping walls and exclude it from the group instance.”

The right side of Figure 7.11 shows the warning message. If you wish, you can expand the warning dialog to get 
more detailed information. Do this with the small icon on the right side of the warning dialog. If the warning has 
closed already, on the Manage tab, on the Inquiry panel you can click the Warnings button to access it and any other 
warnings your project file may have. When you fully expand the error, you can click on each of the overlapping walls 
to highlight them on screen. The one “on top” will highlight more obviously (see Figure 7.12).
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FIGURE 7.12 Click the Expand icon to see a more detailed error dialog

If you wish to see the element highlighted in other views, click the Show button. Each time you click Show, it will 
open another view window and highlight the element in question. When you are done reviewing the warning, click 
the Close button to dismiss it. If you did click show, make sure you return to the Architecture floor plan view and 
then close the other views.

In addition to potentially having an adverse effect on rooms, you can also see that the overlapping walls do not cleanup 
very nicely. The solution to both problems is simple: any element in any group can be excluded from an individual 
instance of the group. In this situation, we can exclude the duplicate wall from one of the groups.

4. Place your mouse over the double wall.

Notice that the group pre-highlights.

 Ö Press the tab key.

Notice that the other group pre-highlights.

 Ö Press the tab key again.

This time, the wall within one of the groups pre-highlights.

5. Click to select this wall.

TIP: Notice that on the Modify | Walls tab, there is a “Show Related Warnings” icon. This gives you a shortcut 
to the Review Warnings dialog discussed above, letting you know that there are warnings associated with the 
selected element.

 Ö Click the Group Member icon in the canvas area to exclude this wall from the group (see Figure 7.13).

 Ö Deselect the group.
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FIGURE 7.13 tab into the group, select the wall and then click the icon to exclude it

Notice that the extra wall has been removed and the cleanup is now correct. It is important to realize that this change 
is not simply graphical override—Revit has removed one instance of one of the walls. For example, were we to have 
counted the walls before we started and then re-count them now, there would be one wall fewer in our model. Rather 
than count the walls, which might prove tricky, let’s do a similar experiment using furniture, which is easier to count.

6. On the Project Browser, double-click to open the Furniture floor plan view.

Furniture elements will appear in the original guest room.

7. Select all the furniture elements.

TIP: Use a window selection to select all the furniture and then click the Filter button on the ribbon to remove 
any unwanted element categories.

 Ö On the ribbon, click the Create Group button (or press GP).

8. In the Create Model Group Name field, type: King-01.

9. Using the technique covered in the “Create a Group Instance” topic on page 253 
above, drag the origin point to the same location as the Guest Room group.

10. Mirror the furniture group to the other guest room (see Figure 7.14).

FIGURE 7.14 Group the furniture, move the origin point, and then mirror a copy

11. On the Project Browser, beneath Schedules/Quantities, double-click to open the Furniture Schedule view.
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Study the table and take note of the totals in the “Count” column. Notice that we currently have 4 Side Chairs 
(Chair-Viper: Chair). This is impressive; Revit gives us an accurate count even when the items it is counting are inside 
groups! Let’s exclude one chair from a group and see the impact on the schedule.

12. Return to the Furniture floor plan.

TIP: Close the Architecture view, and then on the View tab, choose: Tile Windows (or press WT) to see both 
plan and schedule side by side.

13. Using the tab key, select one of the Side Chairs (bottom of the plan, near the windows).

 Ö Click the exclude group member icon to exclude this chair from the group (see Figure 7.15).

 Ö Deselect the chair after excluding it to see it disappear.

FIGURE 7.15 Excluding an item from a group removes it from the schedule as well

Now that is even more impressive; the schedule accurately reflects the quantity shown in the model. This example 
illustrates that you can use the exclude from groups feature with confidence, as Revit will accurately reflect the 
exclusions throughout the model.

TIP: If you lose track of which groups have excluded members, when you highlight them onscreen, a message 
reading: “(members excluded)” will appear on the Status Bar next to the group name. If you select them, a 
Restore all Excluded Members button will appear on the ribbon.

You should try a few more experiments to become comfortable with the full behavior of this feature. For example, 
move your mouse over the missing chair and it will pre-highlight as if it were there. In this way, you can tab back 
into the group and bring the element back (include it). Be careful when editing a group that has overrides applied. 
You can edit either instance of the furniture group onscreen. However, if you edit the one with the excluded chair, 
you will not be able to edit the chair at all. If you instead edit the one without exclusions, you will have the ability to 
edit all its elements including both chairs. You can even move or otherwise edit the chair that is excluded in one of 
the other groups. The change will be visible in the group(s) that shows the chair and not visible in any that exclude 
it. If you like, try some of these experiments now before continuing.
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FIGURE 8.20 Convert the run component to a sketch-based component

By adjusting these sketch lines, we can change the shape of the stair. The stair sketch uses three colors on screen to 
indicate the function of each line. Green indicates a boundary line. There must be two boundary edges. The blue 
line at the center indicates the stair path. Editing this line influences the overall stair, so be careful when modifying 
it. The black lines are the individual risers. A gray text note will also appear near the sketch indicating how many 
risers are created and required.

On the ribbon you’ll see three draw modes: Boundary, Riser, and Stair Path. We can use these to draw new lines of 
each type. You can also use any of the modify tools like Move, Copy, Rotate, and Trim to edit the lines already in 
the sketch.

3. On the Modify | Create Stair > Sketch Run tab, on the Draw panel, click
the Boundary tool (see item 1 in Figure 8.21).

Ö On the Options Bar, make sure that the “Chain” check box is checked.

4. Click the first point of the new boundary Line at the intersection of the right-
hand Boundary Line and the bottom of the existing wall.

Make sure you are snapping to the endpoint of the wall. Use the tab as
necessary to aid in getting the right point (item 2).

Ö Click the next point at the other side of the wall’s width (item 3).

Ö Place the last point aligned with the third riser line and the wall’s right face (item 4).

Ö On the ribbon, click the Modify tool or press the esc key twice.

5. Use the Trim/Extend to Corner tool to remove the unneeded segment (item 5)

Remember to click the part you want to keep.
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FIGURE 8.21 Sketch two new boundary lines snapping to the existing wall for reference (sketch lines enhanced for clarity)

6. On the Modify panel, click the Trim/Extend Multiple Elements tool.

Ö For the Trim/Extend boundary, click the newly drawn green boundary Line (vertical one on the right).

7. Click each of the riser Lines to extend them to this boundary (see Figure 8.22).

Click them one at a time or drag a crossing window selection through them.

FIGURE 8.22 Extend the riser lines to the new boundary line

Ö Click the Modify tool or press the esc key twice.

On the lower portion of the stair, the risers will now come out flush with the wall. Next, we’ll add the bull nose to 
the lower two steps.

ADD A BULL NOSE RISER

To add the bull nose riser, we simply sketch them in using the riser sketch tool on the ribbon.

1. On the Draw panel, click the Riser tool.

Ö On the Options Bar, clear the “Chain” check box.

2. On the Draw panel, click the “Tangent End Arc” icon.

Ö Snap to the right-hand endpoint of the second riser line from the bottom (see item 1 in Figure 8.23).

Ö Move straight up and snap to the endpoint of the green boundary line (item 2).

3. Snap to the right-hand endpoint of the lowest riser line (item 3).

Ö Snap the second point to the endpoint of the green boundary line again (item 4).
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FIGURE 8.23 Add arcs to the lower risers

Ö On the ribbon, click the Finish Edit Mode button.

This returns us to the Modify | Create Stair ribbon. To complete editing, we need to click Finish Edit Mode a second 
time.

4. On the ribbon, click the Finish Edit Mode button.

If a railing warning appears, we can simply ignore it for now.

VIEW THE STAIR IN 3D

Let’s look at our progress in 3D. We have used the “Default 3D View” icon several times already which shows us a 
complete three-dimensional view of the entire model. This works well to see the exterior of the building, but not the 
inside. There are a few ways that we quickly view just the stairs in 3D. Let’s look at one such way.

1. If your views are tiled, use the Tab Views button (or press TW) to group
all tabs into a single window (see item 1 in Figure 8.24).

2. Make sure the First Floor Existing Conditions tab is active and then use the
Close Inactive Views tool to close any other windows (item 2).

3. On the View tab, on the Create panel, click the Default 3D View tool (also on the QAT) (item 3).

Ö On the View tab, on the Windows panel, click the Tile Views button (item 4).

Adjust the zoom as necessary.

FIGURE 8.24 Trim the existing boundary line to join it to the new sketch

4. Click the tab of the First Floor Existing Conditions view tab to make it active.

Ö Select the lower stair, its two railings, and their immediately adjacent walls (see the left side of Figure 8.25).

TIP: Use the ctrl key to click on each object that you wish to add to the selection. Try to avoid selecting the 
basement stair or basement stair railings. Use the tab key as necessary to assist in selection. You can hold down 
the shift key and click an item to remove it if necessary.
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5. Click the tab of the 3D view window to make it active.

Clicking the tab changes views without accidentally deselecting the elements. If you do
loose your selection, immediately right-click and choose: Select Previous.

Ö In the {3D} view window, from the Temporary Hide/Isolate pop-up, choose:
Isolate Element (see the right side of Figure 8.25).

FIGURE 8.25 Select elements in the plan view, isolate them in the 3D view

TIP: If you ended up with basement stairs in the 3D view, you could select them separately in the 3D view 
and then use the Temporary Hide/Isolate pop-up again and choose: Hide Elements.

Feel free to use the ViewCube or the Steering Wheel controls to spin the isolated selection around to an alternative 
viewing angle. With the stairs thus isolated, you should be able to see the two treads at the bottom of the stair and 
their bull nose quite clearly.
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Continue in the Roof plan view.

1. Select the flat roof element. (Use the tab key as necessary.)

Notice the collection of Shape Editing tools appears on the ribbon as shown on the left side of Figure 9.52.

Moving left to right, the tools are as follows:

Modify Sub-Elements—This tool can be used to adjust the height of any points or edges of the shape edited element.

Add Point—Use this tool to add points to the surface of the roof or floor. Each point has a height that you can adjust 
to either a negative or positive offset from the roof or floor level. The roof form will conform to the shape of the edited 
points.

Add Split Line—This tool adds elevation changes using lines instead of points. Like the Draw Point tool, each line 
has a height that you can adjust to either a negative or positive offset from the roof or floor level. You can also edit the 
height of the line’s endpoints independently.

Pick Supports—If you have structural supports set at accurate levels, you can use them to indicate the level changes 
of the roof or floor.

Reset Shape—The button (grayed out in Figure 9.52) is used to remove all edits and return the shape of the roof or 
floor to flat with no slopes.

We’ll perform a simple edit to our roof ’s surface using a few split lines and points.

2. On the Shape Editing panel, click the Add Split Line tool.

This enables a special shape editing mode which is like other sketch modes but has some unique features as well. The 
main difference is that there is no finish edit mode and cancel buttons. To exit this mode, simply click the Modify 
tool as you would any other command. The existing edge of the roof outlines in a dashed green line. New points or 
lines you add will be blue. Gray lines appear when required. They are auto-calculated from the other lines and points. 
These turn out to be trickiest part of using these tools. If you want to avoid many unnecessary gray lines that make 
the shape of the roof overly complex, you need to be strategic with your use of split lines and points.

3. Click a point at the intersection of Grid 2 and the vertical green line on the left.

 Ö Draw straight across along Grid 2 and snap to the opposite green line on the right (see the left side of Figure 9.53).

FIGURE 9.53 Add split lines to divide the roof into three zones

4. Remaining in the Split Line tool, click the green corner point at the lower left side of the stair tower area.

 Ö Draw horizontally to the left and snap at the intersection of the vertical green line.

 Ö Repeat on the other side (see the right side of Figure 9.53).
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FIGURE 9.58 Study the results in 3D

ADJUSTING SLOPE

When designing a flat roof, there is often a minimum slope required by code for drainage. While we cannot input 
this directly in the shape editing tools, we can use a simple technique to measure the slope that results from our edits 
and then make appropriate adjustments.

1. Return to the Roof plan.

2. On the Annotate tab, on the Dimension panel, click the Spot Slope tool.

 Ö Move your mouse around the various surfaces of the roof.

The spot slope annotation symbol will appear on your cursor and will read the slope of each surface as you mouse over 
them. Use this moussing technique for quick measurements or click to place the permanent annotations in the view.

3. Click to place one or more spot slope symbols.

 Ö On the ribbon, click the Modify tool or press the esc key twice.

If you discover a slope that is too shallow, simply select the roof, click the Modify Sub Elements button and then 
adjust the height of some of the points or lines to adjust the slope. You will get immediate feedback from the anno-
tation as you make changes to the heights of the lines or points. In some cases, you may need to add new points or 
lines to achieve positive drainage at all points on the roof.

USING VARIABLE THICKNESS LAYERS

The default behavior in the sub-element editing mode is for the entire roof slab to be affected by the slope. If you prefer, 
you can edit the structure of the roof type applied to the roof element and make one of its material layer thicknesses 
variable. When doing so, the bottom surface of the roof will remain flat, while the top surface slopes according to 
the split lines and elevation points added above. This is an effective way to represent tapered rigid insulation in the 
construction (see the next few steps). The best way to see these sometimes subtle variations is in a section view. Let’s 
use the one we created earlier.

1. On the Project Browser, locate Section 1.

 Ö Right-click it and choose: Rename. Call it: Section at Roof. Stretch the bottom of the 
crop region up so that it only shows us the roof, cropping out the levels below.

Take a close look at the roof element. Notice that both the top and bottom surfaces are sloped (maintaining a uniform 
thickness). We can designate one of the layers in the roof type structure as a variable thickness. When doing so, the 
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ADD A BRICK SHELF

Let’s start with the foundation wall. By modifying the wall type, we can create a brick shelf to receive the bricks from 
the exterior wall above. This will be achieved by adding a reveal directly to the wall type. The process will be similar 
to the one we followed in the “Add a Wall Type Sweep” topic on page 456 in Chapter 10.

1. On the Project Browser, double-click to open the Basement floor plan view.

In the area of the new addition there are four foundation walls; three bounding the outside perimeter and another 
framing the right side of the passageway to the existing basement. We do not want to apply a brick shelf to the wall 
in the passageway. Since we are going to edit the wall type, the easiest way to prevent this is to create a new type for 
the walls needing the brick shelf.

2. Using the ctrl key, select the three exterior foundation walls (two vertical and one horizontal) (see Figure 12.1).

FIGURE 12.1 Select the three exterior foundation walls

Ö On the Properties palette, click the Edit Type button. The “Type Properties” dialog will appear.

Ö Next to the type list, click the Duplicate button (or press alt + d).

A new “Name” dialog will appear. By default “2” has been appended to the existing name.
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The Load Profile button is just a shortcut to loading the profile. You still need to assign it to the reveal. But the nice 
thing about this button is it allows us to load a profile without having to cancel all the way out and start over.

7. Click in the Profile field and then click again on the down arrow to display the Profile list.

 Ö Choose: Brick Shelf Reveal : 12" d × 6" w [Brick Shelf Reveal-Metric: 300 d 3 140 w] (item 2).

 Ö For the “From” setting, choose: Top (item 3) and then click the Apply button (item 4).

FIGURE 12.3 Add a new profile, set it to top, and then click Apply to see the result

In the “Edit Assembly” dialog in the background, you should see the reveal profile appear at the top left edge of the 
wall in the viewer. Move the “Reveals” dialog out of the way if necessary.

8. Click OK to return to the “Edit Assembly” dialog.

 Ö Click OK two more times to return to the Basement view window.

9. On the Project Browser, double-click to open the Longitudinal section view.

 Ö Zoom in on the left side to study the results (see Figure 12.4).

FIGURE 12.4 Open the Longitudinal section view to see the resultsCopyri
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UNLOCK WALL LAYERS

Now that we have a brick shelf in the foundation wall type, we should put some brick there. To do this, let’s edit the 
brick wall type to unlock the outer material layers (to allow their top and/or bottom offsets to move freely from the 
wall’s top and base offsets) and then project them down to sit on the foundation brick shelf.

1. In the section view, select the left exterior brick wall.

 Ö On the Properties palette, click the Edit Type button.

The Preview window should already be open and set to a section preview. If it is not, open 
it again now and choose: Section: Modify type attributes from the “View” list.

2. Click the Edit button next to Structure.

 Ö Right-click in the viewer window and choose: Zoom In Region. Zoom in on the lower portion of the wall.

3. In the “Modify Vertical Structure” area, click the Modify button (see the left side of Figure 12.5).

FIGURE 12.5 Zoom in on the lower portion of the wall and then click the Modify button and unlock the bottom edge of the brick

 Ö Click the bottom edge of the Brick layer.

The edge will highlight light blue to indicate that it is selected. A small padlock icon will appear on the edge. We can 
use this padlock icon to unlock the bottom edge of the layer, which will allow it to be moved independently from 
the wall in the model.

4. Click the padlock (to open it) and unlock the bottom edge of the layer (see the right side of Figure 12.5).

 Ö Repeat the process to unlock the bottom edge of the Thermal/Air Layer (next to brick).

5. Click OK twice to return to the model.

Upon returning to the model view window, you will note that the wall now has two shape handles at the bottom 
edge (see the left side of Figure 12.6). If you don’t see the shape handles, deselect the wall, then select it again. You 
can use the second handle to modify the bottom edge of just the unlocked layers (called Base Extension on the 
Properties palette). The other handle will continue to modify the Base Constraint of the entire wall (see the right 
side of Figure 12.6).
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It should be noted that any two walls that overlap can be joined, yielding results like we have here. You can also 
join to many other elements like floors, roofs, ceilings and several others. The reveal procedure was shown with the 
unlocked brick layers, but the reveal is not required. You can simply unlock the brick layers, extend them down and 
then join to the foundation wall and the result in section will appear the same. Regardless of your specific choice in 
this exercise, reveals will prove a valuable modeling tool for you.
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FIGURE 12.22 View break controls allow you to crop out the middle portion of the section

2. Click one of the view break controls on a vertical edge (there are four 
total; you can pick any one) of the crop boundary.

The view splits into two separate crop regions with a large gap in the middle. A blue arrow control handle appears 
in the middle of each view break region. We can use these to move the two portions closer together. Notice that 
along the vertical edges of each of the two new crop boundaries the same types of control handles appear. You can 
continue to break them into additional sub-views as necessary. But all breaks must be along the same direction as 
the first one—vertical in this case. In this example two is enough so we will not break it any further. However, we 
need to adjust the top view break so we can see the entire anchor bolt.

3. Using the blue dot control handle at the bottom of the upper view 
break, drag the edge down a bit to show all the anchor bolt.

 Ö Click on the view break control (in the middle) of the bottom view break and drag it up so the 
crop region is a little below the upper crop boundary (see the right side of Figure 12.22).

If you continue to drag so that you overlap the two view breaks, they will join back into one. This is how you “remove” 
the break.

CAUTION: Be sure to move the portions of the view breaks with the control arrow in the middle. 
Do not drag the edge of the crop region. Doing so will move the area of the callout in both this view 
and the referring Longitudinal section view.

Although the sub-views are truncated and closer together, distances are dimensionally correct. Look at the level lines 
to the right of the views and note that the heights are unchanged. If we were to add a dimension from the First Floor 
to the Basement, it should read a distance of: 8'-9" [3540]. Let’s try it out to see.

4. On the Annotate tab, on the Dimension panel, click the Aligned tool.

 Ö Add a dimension between the First Floor level and the Basement level.

 Ö Move to the left crop region boundary and click next to it (in the white 
space) to place the dimension string (see Figure 12.23).Copyri
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